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What is Workshare Professional

Workshare Professional reimagines multi-party review and collaboration and ensures the 
safe and accurate exchange of information, enabling the collaborative evolution of high 
value business documents. 

Workshare Professional is a desktop application that automates managing changes to 
business documents, protects against unauthorized content disclosure and delivers the 
world’s most secure PDF creation, all in one integrated solution.

Key features of Workshare Professional include:

 Comparison of Word, PowerPoint, Excel and PDF files, including image-based 
PDF files

 Comparison of selected pieces of content, such as a single paragraph or clause

 Ability to accept/reject in a comparison and then create new documents

 Advanced comparison features including one-to-many comparisons (Word and 
PDF files), version comparisons, and access from within Office and Document 
Management Systems

 Access to comparison functionality from within Outlook as well as right-click access 
from within individual emails

 Conversion from PDF to DOC format for local files and from within the DMS/CRM

 Advanced, interactive metadata cleaning/PDF creation/secure file transfer for 
attachments in Outlook

 Comprehensive content risk protection enabling the discovery and removal of 
hidden sensitive data as well as visible sensitive data

 Options to save and share Office documents to Workshare online

 Access and visibility into online collaborative workspaces directly from Office

 Secure file sharing from all devices and browsers with metadata removal and end-
to-end encryption

 Centralized policy design and enforcement administrator tools

 ECM/DMS and OCR integration with desktop comparison features

 Centralized user account management and control

 Complete access to Workshare online functionality to share and collaborate on 
documents, including setting folder access and permissions, positional commenting 
and reviewer communications with presence indicators

 Desktop sync app to synchronize your online content to your local desktop
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Note: Workshare Professional can be installed without Microsoft Office integration. In this 
case, the comparison functionality is only available from the Workshare comparison
applications and the metadata removal functionality is only available when sending 
emails.

What’s New in Workshare Professional 10.1

The Professional 10.1 Revision 1 release includes the following:

Access compare from within Excel

This release adds the ability to start a comparison of spreadsheets from within Microsoft 
Excel. A Compare button has been added to the Workshare ribbon.

This brings consistency across Microsoft Office applications with Workshare comparison 
now available from with Word, PowerPoint and Excel.

Wider availability of Selective Compare

Selective Compare enables users to run a comparison on snippets of content pasted from 
emails, chats or files. This is much faster and more focused than comparing an entire 
document. This release of Selective Compare has broadened the availability of this feature 
– it is now available from the Workshare ribbon in Microsoft Excel and PowerPoint as well 
as Word and Outlook.
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Improved table comparison

This release introduces an updated method of table comparison that creates more 
readable results in the vast majority of cases. The default rendering set has been updated 
so that this improved table comparison enabled by default.

If for any reason users want to revert to the old method, there is a new rendering set 
option that enables them to do so. The option is called Use classic table comparison
and is found in the Comparison Options group of parameters in a rendering set.
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Access iManage versions

When working with iManage, and the file selected for comparison has versions, the recent 
files list can also include these versions. In this way, you can easily compare different 
versions of your iManage presentations.

To enable this functionality, the Enable version dropdown in selection dialog (iManage 
only) parameter in the Workshare Configuration Manager must be selected.

When a document doesn’t have versions, the dropdown will show only recent files.

Note: Access to iManage versions is not yet available when comparing Excel files.

Workshare Configuration Manager

The following parameter was added:

 Enable version dropdown in selection dialog (iManage only) (Integrations > 
General)
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System Requirements

The recommended system requirements for Workshare Professional 10.1 Revision 1 are:

 Intel Core i3 @ 2.5GHz

 AMD Athlon 64 X4

 4GB RAM

Workshare Professional 10.1 has a 32-bit version for 32-bit Microsoft Office environments 
and a 64-bit version for 64-bit Office environments.

Certified Environments for Workshare Professional 10.1 
(32-bit version)

Workshare Professional 10.1 Revision 1 (32-bit version) has been tested and certified in a 
number of environments. If your environment is not included in the following list, it may still 
be a compatible environment. Contact Workshare Customer Support 
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/Compare/
Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (32 bit and 64 bit)

 Microsoft Windows 8.1 (32 bit and 64 bit) + Japanese

 Microsoft Windows 7 SP1 (32 bit and 64 bit) + Chinese Simplified & French

Citrix:

 With Microsoft Windows Server 2012 R2 or 2016 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop)

 Microsoft Office 2019 (32 bit) – including click-to-run

mailto:support@workshare.com
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 Microsoft Office 2016 (32 bit) – including click-to-run

 Microsoft Office 2013 SP1 (32 bit) + Japanese – including click-to-run

Email System:

 Microsoft Outlook 365 (desktop)

 Microsoft Outlook 2019 (32 bit)

 Microsoft Outlook 2016 (32 bit)

 Microsoft Outlook 2013 SP1 (32 bit) + Japanese

 IBM Notes 9.0.1 FP7, FP8 and FP9

Note: Interactive Protect and the replace email attachment with link features of 
Workshare are not supported in a Notes environment.

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version

Microsoft SharePoint:

 Microsoft SharePoint 2013 SP1

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.0 Update 6 and above

 Work 10 Desktop for Windows 10.0 and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
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Note: If you use a Work 10.2 server, it must include iManage Work Web Server 
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

 OpenText: 

 eDOCS DM 16.3

 eDOCS DM 10

 eDOCS DM 5.3.1 COM only (Patch 6)

 Worldox:

 GX4

Workshare will endeavor to support future service packs of certified environments.

Certified Environments for Workshare Professional 10.1
(64-bit version)

Workshare Professional 10.1 Revision 1 (64-bit version) has been tested and certified in a 
number of environments. If your environment is not included in the following list, it may still 
be a compatible environment. Contact Workshare Customer Support 
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/
Compare/Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (64 bit)

Citrix:

 With Microsoft Windows Server 2012 R2 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix.

Microsoft Office System:

 Microsoft Office 365 (desktop) (64 bit)

 Microsoft Office 2019 (64 bit)

 Microsoft Office 2016 (64 bit)

mailto:support@workshare.com
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 Microsoft Office 2013 SP1 (64 bit)

Email System:

 Microsoft Outlook 365 (desktop) (64 bit)

 Microsoft Outlook 2019 (64 bit)

 Microsoft Outlook 2016 (64 bit)

 Microsoft Outlook 2013 SP1 (64 bit)

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.3 (64 bit) and above

 Work 10 Desktop for Windows 10.0 (64 bit) and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server 
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

 OpenText: 

 eDOCS DM 16.3

 eDOCS DM 10

Workshare will endeavor to support future service packs of certified environments.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
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Important Information

Secure PDFs – Workshare Professional is unable to compare secure PDFs or convert 
secure PDFs to Word format. Secure PDFs are PDF files with security settings configured.

POP/IMAP – Workshare Professional does not support Outlook when it is configured with 
a POP or IMAP account.

Important installation information

 Workshare Professional installs program files to a sub-folder within the Workshare 
folder named Modules.

 Install: A user is unable to install Workshare Professional if Microsoft Windows 
Installer 3.1 is not installed. This can be downloaded from the following location 
https://www.microsoft.com/en-us/download/details.aspx?id=25.

 Windows 7: When UAC is set to Default, running the Workshare Professional 
install displays the UAC prompt. You must approve the prompt and Workshare 
Professional will be installed. Running the Workshare Professional MSI silently will 
fail when UAC is set to Default because the user is not given the opportunity to 
approve the UAC prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Professional, we strongly 
recommend that you first uninstall them before installing Workshare Professional 10.

Change Requests Fixed

The following are fixed customer change requests that have been validated for this release 
- for more information, please contact Customer Support.

Ref CR# Description

PRO-1143 Rows are displayed as inserted and deleted in the redline 
when data of all cell of a row is changed in modified 
document

PRO-1144 Cells are rendered as merged in the redline when data of a 
cell in a row is deleted

PRO-1170 Inserted blank columns of the source documents are 
displayed as merged in the redline.

PRO-2789 CR01164186 Comments and Track Changes are not being removed when 
both 'Delete text smaller than 5pt (Word)'and 'Delete white 
text on white background (Word)' options are enabled in 
WCM using convert to PDF

https://www.microsoft.com/en-us/download/details.aspx?id=25
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Ref CR# Description

PRO-2924 CR01165465 Workshare fails to uninstall on Windows 10, version 1809, 
build 17763.107

PRO-2927 Connect to server' server list is not displayed on Open/Save 
dialog when three 10.1 or 10.2 servers are registered in 
WCM

PRO-3063 CR01166236 Quotation marks are shifted slightly to the right and overlaps 
the character slightly when saving or printing to PDF

PRO-3120 Selective compare and Workshare batch clean are not 
responding when FIPS Algorithm is enabled in GPO

PRO-3145 Compare for PPT is not launching when FIPS Algorithm is 
enabled in GPO

PRO-3318 Workshare compare crashes when comparing the data from 
Selective Compare for the second instance of Compare

PRO-3323 Please log into Workshare Desktop Agent' message is 
displayed while performing Link actions from outlook even 
though user is logged into Workshare Desktop

PRO-1762 CR01157226 Error message 0x80004005 displayed and unable to save 
comparison document using iManage Work 10

PRO-2269, 
PRO-2477

CR01161767 Error: The comparison couldn't be performed. Try running a 
comparison with other files when comparing specific Excel 
files

PRO-2652 Failed to save Redline' error message is displayed when 
saving the comparison.

PRO-2862 CR01164585 Manage box being displayed behind Workshare desktop 
app

PRO-2963 CR01165089 Word Workshare ribbon Content Risk button fails when 
FIPS Algorithm is enabled in GPO

PRO-3079 Error message '(0x80004005)' is displayed when saving 
redline for second instance

PRO-2951 iManage Open file dialog is failing to retrieve document 
under certain conditions

PRO-2995 Microsoft Excel is not displayed under supported addins 
section on the install dialog
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Known Issues

The following are known issues in the Workshare Professional 10.1 Revision 1 release -
for more information, please contact Customer Support.

Ref Description

PRO-3409

01168025

iManage integration: After an upgrade, the recent files list in Compare’s 
Document Selection dialog retains the recent files compared prior to the 
upgrade. However, you are not able to compare those recent iManage files 
because the path is shown as “interwovenSite://…” rather than 
“iManage://…”.

PRO-3407

01168003

NetDocuments integration: The Email Security dialog box appears a second 
time after selecting an ndMail filing location.

PRO-3239

01167599

iManage integration: After adding your Work 10 server to the Administrator 
Mode of the Workshare Configuration Manager (Integrations > iManage) the 
test connection may fail in certain circumstances.

PRO-3238

01167456

iManage integration: In certain circumstances The error “Document profile is 
invalid” may be displayed when saving a comparison to iManage Work 10.

PRO-3137

01166593

When cleaning metadata from a PowerPoint attachment with the lightspeed 
clean option enabled, the slide animation sequence may be removed.

PRO-3062

01165945

Unexpected results may occur when exporting an Excel comparison with the 
'Indirect highlights' option selected but without all the other options selected.

PRO-3029

01165948

Upgrading from Workshare 9.5.x to 10.x does not honor the 'File Share & 
Sync' module state.

PRO-2609

01163333
Links in Excel documents are detected again even after removal.

PRO-2513
Errors can occur when using Selective Compare if Compare dialogs are 
open and the "Launch new comparison in running instance" configuration 
option is enabled.

PRO-1387
Compare for Excel: Changes may not be indicated correctly when 
comparing spreadsheets with a deleted/inserted column when the first row is 
empty.

PRO-1386
Compare for Excel: Merged cells are displayed as individual cells when the 
merged cell is not in full view on the comparison window.

PRO-1019
Compare for Excel: Focus is not completely applied to the last change in the 
comparison window if the user clicks the Last Change button for the first 
time.

PRO-918

01130757

After running a comparison in Workshare Compare, some Chinese 
comments may not be displayed in the redline.
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Ref Description

PRO-879

01085082

After running a comparison in Workshare Compare, certain financial tables 
may show incorrect insertions and deletions.

PRO-837

01061816

After running a comparison in Workshare Compare, the right aligned text in 
the footer may move to become center-aligned.

PRO-792

01088791

After running a comparison in Workshare Compare, some line numbering 
and table text and row cells maybe be missing.

PRO-782

01129790

The OpenText save dialog appears in the background when saving redlines
to OpenText.

PRO-690

01125849

When sending documents for comparison from NetDocuments on Citrix, the 
following error is displayed even though the documents are compared 
successfully: “80040154 Class not registered (Exception from HRESULT: 
0x80040154(REGDB_E_CLASSNOTREG))”.

PRO-528
IBM Notes 9.0.1 FP7 only. Attachments are duplicated in sent items when 
the email is processed through desktop profiles or all mail profiles. This is an 
issue with IBM Notes.

PRO-527
IBM Notes only. Attachments are not automatically compressed to a zip file
when the limit specified in the WCM is reached.

PRO-525
The positioning of signature components in RTF format emails can be 
incorrect after processing with Protect.

PRO-109

01099537

The error ‘Failed to compare documents. Unable to convert documents.’ is 
displayed when comparing specific scanned PDF documents.

PRO-22
The Reset Layout option is missing from the Quick Access Toolbar 
drop-down in Compare for PowerPoint.

01012100
The account or company name is not displayed in File > Help > About in 
Workshare Compare.

01018577
Worldox document footer stamps are not updated when saving a 
comparison via Save As in Workshare Compare.

01018743
The font in the email body changes to Times New Roman when sending 
attachments to groups in Interactive Protect.

01028440
Editing a rendering set on the fly does not prompt to save as a new set or 
overwrite the current rendering set.

40418
When comparing particular presentations, 'Index was outside the bounds of 
the array' error is displayed.

40430
When comparing presentations and at least one has the Opulent design 
theme applied, a ‘Color is not resolved yet’ error is displayed.

http://www-10.lotus.com/ldd/fixlist.nsf/8ed1b46cfdba8957852570c90054623b/dbf1eb80caf496f0852580d800738d12?OpenDocument
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Ref Description

40469
In Compare for PowerPoint, a newly created comparison theme does not 
appear in the Select dropdown in the Home ribbon (Comparison Themes 
group).

40574
A user is not automatically logged into Professional after logging into the 
desktop app first (64-bit version only).

40597
The local file store dialog is displayed when browsing for files from the 
desktop app when a DMS is set as the default (64-bit version only).

41284
In Compare for PowerPoint, comparisons of DMS files are not listed in the 
recent comparison list (File > Open > Recent).

41547
When a PowerPoint presentation is run from the command line, the incorrect 
comparison theme is highlighted under the Select dropdown in the Home 
ribbon.

45583
When a machine is restarted before the convert to link process has 
completed, files which are not synced are moved to a conflict state in the 
desktop app.

Contact Info

For technical help and support on Workshare products, contact Workshare Customer 
Support:

support@workshare.com
EMEA: +44 207 539 1400
US: +1 415 590 7705

For sales enquiries, contact the Workshare Sales team:

sales@workshare.com
EMEA: +44 207 426 0000
US: +1 415 590 7700
APAC: +61 2 8220 8090
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Workshare Ltd.
© 2019. Workshare Ltd. All rights reserved.

Copyright
Workshare Professional and Workshare DeltaView are registered trademarks of Workshare Ltd. Workshare Compare, 
Workshare Protect, Workshare 3, Workshare DeltaServer, SafetyGain, and the Workshare logo are trademarks of 
Workshare Ltd. All other trademarks are those of their respective holders.

Trademarked names may appear throughout this guide. Instead of listing these here or inserting numerous trademark 
symbols, Workshare wishes to state categorically that no infringement of intellectual or other copyright is intended and 
that trademarks are used only for editorial purposes.

Disclaimer
The authors/publishers of this guide and any associated help material have used their best efforts to ensure accuracy 
and effectiveness. Due to the continuing nature of software development, it may be necessary to distribute updated help 
from time to time. The authors would like to assure users of their continued best efforts in supplying the most effective 
help material possible.

The authors/publishers, however, make no warranty of any kind, expressed or implied, with regard to Workshare 
programs or help material associated with them, including this guide. The authors/publishers shall not be liable in the 
event of incidental or consequential damages in connection with, or arising out of, the programs or associated help 
instructions.

For details of Workshare patents, see www.workshare.com/patents

Revisions
Published for Workshare Professional 10.0: 18/12/18; minor revisions: 17/1/19 & 15/2/19
Revised for Workshare Professional 10.1: 27/3/19
Revised for Workshare Professional 10.1 Revision 1: 16/5/19

Workshare Ltd., 20 Fashion Street, London E1 6PX www.workshare.com

http://www.workshare.com/patents
http://www.workshare.com/
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